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Conventions used in this guide
Typographical

conventions
The following typographical conventions are used in this guide:

Noteboxes The following types of noteboxes are used in this guide:

Font Usage

Bold Any text that you see in the user interface appears in bold. This 
font is used, for example, for window and dialog box titles, box 
and button names, and list items.

Italic bold New terms are in italic bold when they appear in the current 
context for the first time.

Monospace Extracts of program code, HTML, or other material that you 
would normally edit in a text editor, appear in monospaced 
font.

This font is also used for file names and folder paths, and for 
any text that you should type yourself.

A tip might introduce a shortcut, or suggest alternative ways of 
doing things.

A note draws attention to details that you might easily overlook. It 
can also point you to other information in this guide that you might 
find useful.

You should always read very important notes and warnings, like 
this one. They will help you avoid making serious mistakes, or 
wasting your time.

This symbol indicates advanced or highly technical information 
that is usually of interest only to advanced or technically-oriented 
readers.
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1 New web tutorials page

You can now find Tekla Structures support videos and tutorials on the new Web tutorials web site at 
http://www.tekla.com/webtutorials. All available official videos and tutorials are now collected on 
this web site, and the site is available in nine languages. 

You can access the Web tutorials web site also from Tekla 
Structures by clicking Help > Web Tutorials.
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2 Tekla Structures 18.0 Release Notes

Tekla Structures version 18.0 is a main version and contains many new features and fixes.

Compatibility You can open and work with existing models using Tekla Structures 18.0. 

We suggest that you complete any models you have started using your current version.

Installing Tekla Structures setup creates a new subfolder for Tekla Structures 18.0.

You need Windows Administrator rights to install Tekla Structures 18.0. This ensures that all 
Windows system folder *.dll files are updated. 

Tekla Open API
Release Notes

To learn about the improvements in Open API development, see the Tekla Open API Release Notes on 
the Tekla Extranet under Tekla Structures > Product > Open API.

Extensions You can use extensions to expand the capabilities of Tekla Structures. These tools are enhanced and 
developed rapidly and they are available through the Extensions download page on the Tekla 
extranet. To view and download extensions, go to https://extranet.tekla.com/BC/tekla-
structures-en/product/extensions/Pages/Default.aspx. 

When you create or save a model in Tekla Structures 18.0, you 
cannot open it in older versions of Tekla Structures.

Tekla Structures 18.0 uses .NET Framework 4.0, which is installed as 
a prerequisite to the computer you are installing Tekla Structures 
to. In case you already have a beta version of the .NET Framework 
4.0 installed on your computer, you need to uninstall it or replace it 
with the official version of the NET Framework 4.0 available in the 
Microsoft web site.
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3 New Features and Improvements

3.1 Feature map
This feature map lists all the new features in Tekla Structures 18.0 and the configurations they are 
available in. To navigate in the release notes, click the link in the New Feature column.
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General

Construction 
Management module (14)

* * * *

Changes in the cold rolled 
component installation 
(15)

* *

Reinforced Concrete 
Detailing configuration is 
now called Cast in Place 
(16)

* *

New Russian fonts (17) * * * * * *

Modeling

New tool for modifying 
parts (17)

* * * * *

New tool for setting the 
work plane (20)

* * * * *

Improvements in creating 
model templates (20)

* * * * * *
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Improvements in inserting 
reference models (22)

* * * * * *

Improvements in Model 
Organizer (22)

* * * * * *

Examining the contents 
of a reference model

* * * * * * * *

Longer bolt and bolt 
assembly names (25)

* * * * *

Reinforcement

Reinforcing Bar Shape 
Catalog (26)

* * * * *

Improvements in 
reinforcing bar diameter 
handling (29)

* * * * * * * *

Displaying reinforcement 
meshes as outlines (29)

* * * * * * * *

Improvements in Rebar 
Shape Manager (30)

* * * *

Drawings

Improvements in drawing 
views (32)

* * * * * *

Improvements in drawing 
colors (36)

* * * * * *

More flexible dimensions 
and dimension marking 
(37)

* * * * * *

New tool for 
dimensioning reinforcing 
bar groups (39)

* * * * *

Improvements in texts, 
marks and associative 
notes (40)

* * * * * *

Improvements in pullout 
pictures (41)

* * * * *
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Improvements in Rebar 
mesh view creator (43)

* * * * * *

Improvements in welds 
(44)

* * * * * *

Import and Export

New way of defining 
property sets in IFC export 
(48)

* * * * * *

Improvements in IFC 
object conversion (52)

* * * * *

Importing from Tekla 
BIMsight (55)

* * * * * *

Improved reinforcement 
export in Publish to Tekla 
BIMsight (51)

* * * * * *

Analysis & Design

Improvements in 
changing model creation 
method (56)

* * * * *

Improvements in setting 
analysis properties for 
parts (55)

* * * * *

Task Manager

Improvements in Task 
Manager (56)

* * * * * *

Steel Components

Tensioner (7) (57) * * * * * *

Offshore (9) (59) * * * * * *

Tensioner brace (13) (60) * * * * * *

Column - 2 beams (14) 
(62)

* * * * * *

Generation of purlins (50) 
(63)

* * * * * *
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3.2 General

Construction Management module
Construction Management module offers the same functionality as the Construction Management 
configuration for fabricators, detailers, and engineers. You can acquire the Construction 
Management module for any modeling configuration. The module allows you to utilize the model 
information through your fabrication workflow, using the functions of Model Organizer, Task 
Manager, and Clash Check Manager. Previously, all the functions were available in the Full and 
Construction Management configurations only.

Squeezed tube bolted 
(102) (65)

* * * * * *

Concrete Components

Sandwich And Double 
Wall (1) (67)

* * * * * *

Sandwich Wall Horizontal 
Seam (1) (69)

* * * * * *

Sandwich Wall Vertical 
Seam (1) (70)

* * * * * *

Sandwich Wall Window 
(1) (71)

* * * * * *

Electric box in wall (84) 
(73)

* * * * * *

Concrete beam-beam 
(112) (75)

* * * * * *

Concrete foundation 
(1030) (77)

* * * * * *
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For more information on how to acquire the Construction Management module, contact your local 
Tekla reseller.

For more
information

Introduction to Task Manager

Organizing the model

Clash Check Manager

Changes in the cold rolled component installation
In Tekla Structures 18.0 the installation and the file location of cold rolled components have 
changed.

• Cold rolled components are now automatically installed to all users. The dialog box for selecting 
the cold rolled components has been removed from the installation in Tekla Structures 18.0.
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• Cold rolled component data files (.dat files) are now located under the Program Files, in the 
..\Program Files\Tekla Structures\<version>\applications\cold_rolled 
folder.
Previously the data files were located under each environment,  in the 
..\ProgramData\Tekla 
Structures\<version>\environments\<environment>\profil\cr folder.

• The cold rolled components now first search the local environment profil folder for the files 
related to cold rolled components. If the files are not found, then cold rolled components search 
the files from the ..\applications\cold_rolled folder.

Previously cold rolled components only searched the local profil folder.

Reinforced Concrete Detailing configuration is now called Cast in Place  
The name of the Reinforced Concrete Detailing configuration has been changed to Cast in Place.
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New Russian fonts 
There are two new Cyrillic Russian GOST standard True Type fonts in Tekla Structures version 18.0:

• GOST 2.304-81 type A.ttf

• GOST 2.304-81 type B.ttf

Both of the fonts are located in the ..\ProgramData\Tekla 
Structures\<version>\environments\common\fonts folder.

These fonts are needed in all those projects where you want to show text both in local and in Cyrillic 
font types side by side or on top of each other, for example, in part marks or in drawing templates.

To take these fonts into use, copy them from the above mentioned folder to the Windows\Fonts 
folder through Windows Explorer, or open the font file and select Install.Also, if you are using other 
than Russian language Windows, set the current language for non-Unicode programs to Russia in 
Windows Control Panel > Region and Language > Administrative. This requires Windows restart.

3.3 Modeling

New tool for modifying parts
It is now fast and easy to modify the shape of parts and cuts by dragging the part edges and 
surfaces using the new Modify tool. The Modify tool makes modeling more efficient as you see the 
modify result immediately. You can easily make changes without having to enter any part 
properties. 

To start the tool:
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1. Select a part.
2. Right-click and select Modify.

Tekla Structures displays the handles you can use to modify the part. The relevant dimensions are 
shown when you move the mouse slowly over the part edges. To display a grid that shows the 
dragging direction hold the mouse on top of a handle.

 To modify:

1. Select a handle.
2. Drag the handle to a new location.

Use the Ctrl key to disable snapping, and to select and drag multiple points and edges.

For example, drag a corner of a polygon plate as shown in the image.

You can modify the shape of beams, polybeams, columns, pad footings, simple panels, simple strip 
footings, slabs, and contour plates. You can also change the profile of rectangular parts by dragging 
the part corners or modifying the dimensions.

Note that while you can modify the shape and the profile, there are limitations to what extent the 
parts can be modified. For example, you cannot change a beam to a polygon plate. 

The following image shows the different handle types:
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You can control the handles using the toolbar  that opens when you select a handle 
and right-click. Follow the tooltips to modify the handles. To delete a handle, select it and press the 
Delete key.

For more
information

Creating and modifying parts 

Handle

Point handle

Point handles are located where part handles would be.

Midpoint handle

Use midpoint handles to create new point handles.

Line handle

Dimension end point

You can drag either the round handle or the arrow handle.

You can also change dimensions by selecting a dimension 
end point and entering a dimension value in the dialog box 
that opens when you start typing.
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New tool for setting the work plane
It is now easy to set the work plane using the new work plane tool. Click View > Set Work Plane > 
Using the Workplane Tool to start the tool. Move your mouse over your model. Tekla Structures 
shows a preview of the work plane direction with the coordinate symbol. You can set the work plane 
to any part surface.

For more
information

Work plane

Improvements in creating model templates 
In Tekla Structures  18.0, you can now easily save your model as a model template using the new 
File > Save as Model Template... command. Previously, model templates were saved by editing the 
model's TeklaStructuresModel.xml file.

In the Save as Model Template dialog box you can select which catalogs, model subfolders, 
drawing templates and report templates from the model are included in the model template.
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If there are no catalogs and templates in the model folder, the options are not available. Note that 
only the items located in the model folder can be included in the model template.

By default, the model template folder is saved in your environment folder. For example, if your 
model environment is in C:\ProgramData, the model template folder for the default environment 
is in C:\ProgramData\Tekla 
Structures\17.1\environments\default\model_templates.You can define a different 
location using the XS_MODEL_TEMPLATE_DIRECTORY advanced option. For example, you can set this 
advanced option to point to the same location as XS_FIRM.

When you create a new model, you can select the model template you have created from the Model 
template list in the New dialog box.

For more
information

Model templates

Creating a model template
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Improvements in inserting reference models
In Tekla Structures  18.0 it is now easy to extend the work area when inserting a reference model in 
a model. 

If the inserted reference model lies outside the work area and thus is not fully or at all visible in the 
model view, Tekla Structures displays the Objects outside the work area warning message. You can 
select Expand to extend the work area immediately to see the reference model in the model view. 

You can also select not to extend the work area and view the reference model in the model view 
later by using the Fit Work Area to Entire Model command. Ensure that you have selected to 
display reference objects in the view properties.

The warning message is also displayed when inserting reinforcing bars, grid planes, distances and 
sketched items that would otherwise be placed outside the current model view.

For more
information

Inserting a reference model

Improvements in Model Organizer
The following fixes and improvements are now available in Model Organizer:

• It is now easier to arrange the logical areas and object type categories by dragging and 
dropping them to a new location in Model Organizer. In addition, you can now copy and paste 
object type categories.

Model Organizer now shows the number of all objects in an object type category, including the 
objects in the subcategories.
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TT65986

• You can now create an object type category for assemblies and cast units. To change a generic 
object type category to the assembly type, select the Set category for assemblies command. To 
change an assembly object type category to the generic type, select the Set category for all 
objects command.

TT66112

• You can now easily classify the model objects that belong to a selected Object Type category.
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TT66834

• You can now define which properties are shown in the object pane for each object type 
category. You can select these properties in the Properties dialog box. It is possible to map a 
property to more than one report property, for example, you can map NAME to report properties 
NAME and MAINPART.NAME. You can write the these properties in the Report property column 
using ; as the separator. 
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TT66828

• You can sort the columns in the object pane by dragging and dropping the column headings.
TT66664

• When you select an object type category, the objects in the category are now highlighted in the 
model faster than before.
TT66779

• The Model Organizer export xml file now contains the GUID object identifier.

TT67707

For more
information

Organizing the model

When you open a model that has been created with Tekla 
Structures 17.0 or earlier, Model Organizer needs to convert the 
model to be able to use it in the newer Tekla Structures version. 
After the conversion, the model cannot be used with an older 
Model Organizer version anymore.
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Modifying the object pane

Classifying objects in object type categories

Examining the contents of a reference model
You can now examine the contents of a reference model by using the Inquire command. This is 
useful to do for example after you have imported a reference model into Tekla Structures.

For more
information

Examining the contents of a reference model

Longer bolt and bolt assembly names
It is now possible to have longer bolt and bolt assembly names in the bolt catalog and the bolt 
assembly catalog.

• Bolt names can now have 40 characters.

• Standard bolt names can have 25 characters.

• Standard bolt assembly names can have 30 characters.
• All bolt assembly properties can have 25 characters.
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For more
information

Viewing or modifying the bolt catalog

Viewing or modifying bolt assemblies

3.4 Reinforcement

Reinforcing Bar Shape Catalog
Tekla Structures 18.0 introduces a new method for creating a reinforcement: Reinforcing Bar 
Shape Catalog.

Compared to the current reinforcement commands, or the reinforcement system and custom 
components, Reinforcing Bar Shape Catalog lets you to create reinforcements in a new, more 
dynamical way. The reinforcement creation is more productive and intuitive, and can be done with 
only a couple of mouse-clicks. You do not need to pick several points to create a reinforcement, or 
to worry about finding a suitable component. 

When you open Reinforcing Bar Shape Catalog, you will have a list of predefined reinforcement 
shapes with dimensions in your use. The predefined shapes are based on the shapes that have been 
defined in Rebar Shape Manager and saved in the RebarShapeRules.xml file. 

If you modify the bolt catalog and the bolt assembly catalog in 
Tekla Structures  18.0, you cannot open the modified catalogs in 
older Tekla Structures versions.
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When you have selected a shape from the list and are about to place the reinforcement in the 
model, move your mouse over part faces and edges. Tekla Structures then displays the different 
placement options for the reinforcement. Based on the preview you can easily select the desired 
placement.

Reinforcements created with Reinforcing Bar Shape Catalog behave in the same way as 
reinforcements created with the existing reinforcement commands. You can modify, copy, or delete 
the reinforcements, and the reinforcements adapt to the changes made to the part they are placed 
in.

How to use To create a reinforcement using Reinforcing Bar Shape Catalog:

 Reinforcing Bar Shape Catalog does not work with tapered 
reinforcing bar groups.

Reinforcing Bar Shape Catalog works mainly with flat, 2D shapes.



ReinforcementNew Features and Improvements 29

1. Click Detailing > Create Reinforcement > Shape Catalog.
2. Select one of the predefined shapes from the tree view on the left.

You can add frequently used shapes to the tree view, or delete the shapes that you do not need.

To add more shapes or categories to the tree view:

a Click Organize catalog....
b Create new category folders.
c Drag and drop the selected shapes to the folders.
d Change the names of the folders, if needed.
e Click OK.

3. Modify the leg lengths, general reinforcement properties, hook properties, or the group 
properties, if needed.

4. Click OK to close the Reinforcing Bar Shape Catalog dialog box.
5. In the model, place the mouse over a part face or edge.

A preview showing the placing and dimensions of the reinforcement is displayed.

To change the reference point of the reinforcement, double-click 
the different legs or hooks in the preview of the shape.

The hook properties are visible only if you have set the advanced 
option XS_REBAR_RECOGNITION_HOOKS_CONSIDERATION to FALSE.

If you select an existing reinforcement in the model and click the 
Get button, the properties of that reinforcement are displayed in 
the Reinforcing Bar Shape Catalog dialog box.
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6. Based on the preview, select a placing for the reinforcement and click the left mouse button.
The reinforcement with handles is created.

7. If you need to adjust the reinforcement:

• move or drag the start and end handles

• use Mini Toolbar to modify the properties

• use the Reinforcing Bar Properties dialog box to modify the properties.

For more
information

Working with reinforcement

Modifying reinforcement

Reinforcing bar bending shapes in Rebar Shape Manager

Improvements in reinforcing bar diameter handling 
The actual diameter of reinforcing bars with the ribs is now used by default in all cases. Previously, 
the nominal diameter was used in most cases. This change improves the accuracy of reinforcing bar 
dimensions extracted from the models for manufacturing.

You can make reinforcing bars use the nominal diameter by setting the advanced option 
XS_USE_ONLY_NOMINAL_REBAR_DIAMETER=TRUE. However, when reinforcing bars are exported (for 
example, Unitechnik and BVBS), the nominal diameter is always used in the exported definitions 
regardless of this option.
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When previously created models are opened in Tekla Structures 18.0, the center line of the 
reinforcing bars stays in place and the concrete cover is reduced. All bending dimensions of the 
reinforcing bar increase. To solve this problem, either set the reinforcing bars back to nominal 
diameter as explained above or modify the covers of all reinforcing bars to the correct value.

For more
information

Reinforcing bar

Basic reinforcement properties

Displaying reinforcement meshes as outlines
You can now define how reinforcement meshes are displayed in a view. In the View Properties 
dialog box, click Display... and select either Exact or Fast representation for reinforcing bars. Fast 
representation corresponds to the outline representation used in drawings. Single reinforcing bars 
and reinforcing bar groups are always displayed in exact representation, even if fast representation 
is selected.

For more
information

Defining which objects are displayed

Reinforcement mesh

Do not change this option during a project.

When you open a model created with a previous version and that 
model contains reinforcing bars, you must update all reinforcing bar 
components. Otherwise, some of the reinforcement dimensions in 
reports will be incorrect.



ReinforcementNew Features and Improvements 32

Improvements in Rebar Shape Manager
• Previously, when you edited a new RebarShapeRules.xml file with older versions of Rebar 

Shape Manager, some data was lost. Rebar Shape Manager now checks the file version used:
• You can open an old RebarShapeRules.xml file with a newer version of Rebar Shape 

Manager but a warning message is displayed. If you save the file, you cannot use it in older 
Rebar Shape Manager versions anymore.

• You cannot open a new RebarShapeRules.xml file with older versions of Rebar Shape 
Manager. Trying to open the new file displays an error message.

TT70463

• Rebar Shape Manager shows the standard radius value (RS) which is closest to the actual 
bending radius. This is in line with the Select reinforcing bar option and the Main / Tie or 
stirrup default usage setting.
TT62679

• Rebar Shape Manager shows the result of a valid formula in the Bending schedule fields. This 
makes the usage of formulas much easier and faster as it helps to make sure that the formula is 
correct and gives the expected value.
If the formula is not valid, a question mark is shown and/or an error text about:

• non-matching or missing parenthesis
• unknown variable name

• invalid operator

TT65556

• You can use the following new values when reporting the number of rounds and spiral pitch 
height for spiral shapes:
• SR - Spiral rounds

• SL - Spiral length

• SP - Spiral pitch

You can use these values when defining custom shape code rules and schedule field values 
for report templates.

TT64090

• Rebar Shape Manager functions correctly when the 
XS_REBAR_RECOGNITION_HOOKS_CONSIDERATION advanced option is set to FALSE. When set 
to FALSE, Tekla Structures ignores hooks when it checks the shape of reinforcing bars, and 
assigns the same bending type to bars with and without hooks. Hook properties are now 
available as predefined values in a pop-up menu.
TT67044

• The Require hooks option has been changed to Check hooks. When you select the Check 
hooks check box, the different shape codes for reinforcing bars with the same geometry are 
now better and more precisely recognized than before.
TT67055

• Previously, Rebar Shape Manager did not function properly if the advanced option 
XS_REBAR_RECOGNITION_HOOKS_CONSIDERATION was set to FALSE. This has now been fixed. 
With the Check hooks option, reinforcing bars that have different hooks can have different 
shape codes and/or schedule fields regardless of the value of the advanced option. The Check 
hooks option replaces the Require hooks option.
TT69271
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• There are new bending schedule fields for Along leg distances (K) and Off from leg distances 
(H). You can select a property for the field by right-clicking the cell. The Leg distances (D) 
schedule field also has a list of options available. The distances are measured parallel or 
perpendicular to a certain leg from outer edge to outer edge or tangential to the bending. The 
distances are positive or negative depending on the leg direction.
The following images show examples of the K and H dimensions.

TT66883

• K and H fields are available in the Bending schedule fields. 
TT65369

• In some environments, both stirrups and main reinforcing bars with a standard radius are 
recognized as having the same bending type depending on reinforcing bar usage (main or tie/
stirrup). There are now four new variables DIAX2, DIAX3, DIAX5 and DIAX10 for defining 
reinforcing bar bending shape rules. You can create more restrictive rules, such as RX Less 
than DIA*3 to make a difference between reinforcing bars with small and large standard 
radius values.
TT71002

• The Along leg (K) and Off from leg (H) dimensions in Rebar Shape Manager were not saved 
correctly into the RebarShapeRules.xml file when they were used in rules or formulas, or in 
schedule fields. This has now been fixed. However, all shape definitions that contain K or H 
dimensions must be updated by reselecting the schedule field containing any of the K or H 
dimensions. 
TT72308
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• Reinforcing bar minimum and maximum length and weight values LENGTH_MIN, LENGTH_MAX, 
WEIGHT_MIN and WEIGHT_MAX are now read from Rebar Shape Manager if advanced options 
XS_USE_USER_DEFINED_REBARSHAPERULES and 
XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT are both set to TRUE.
TT71906

• Length and weight values of single reinforcing bars are read from the Rebar Shape Manager if 
the advanced options XS_USE_USER_DEFINED_REBARSHAPERULES and 
XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT are both set to TRUE, otherwise 
hardcoded shape values are used like before.

TT72411

For more
information

Reinforcing bar bending shapes in Rebar Shape Manager

Defining reinforcing bar bending shapes in Rebar Shape Manager

3.5 Drawings

Improvements in drawing views
Drawing views include several improvements and functional changes.

View boundary • When you select a drawing view by clicking the frame, the view boundary of the selected 
drawing view is now highlighted in all drawing views, which allows you to easily adjust the 
view boundary in all of the views. When you change the selected view's boundary in the other 
views using view boundary handles, the change can be seen in the view boundary of the 
selected view. This way you can easily adjust the section view plane and view depth, and you do 
not need to go to the view properties dialog box to do this.

In the example below, the view in the bottom-left corner has been selected, and the view 
boundary is shown and highlighted in two other views.
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TT67725

• There are a couple of new advanced options for visualizing the view boundary in other views, 
both located in the Drawing Views category:

• XS_VISUALIZE_VIEW_IN_ANOTHER_VIEWS: Set this advanced option to TRUE if you want 
to highlight the view boundary box of the selected view in another view. If you do not want 
to highlight the view boundary box in another view, set this advanced option to FALSE. The 
default value is TRUE.

• XS_VISUALIZE_VIEW_IN_FATHER_VIEW_ONLY: Set this advanced option to TRUE if you 
want to visualize the section view and detail view boundary boxes only in the view where 
the section mark or the detail mark is located. If you set this advanced option to FALSE, the 
view boundary boxes are visualized in all of the views where this is possible and the view 
boundary box fits inside the view to some extent. The default value is TRUE.

• XS_VISUALIZE_VIEW_NEIGHBOUR_PART_EXTENSION is by default set to TRUE to show 
neighbor part extensions in drawing views. If you set this advanced option to FALSE, the 
neighbor part extensions are not shown. 

When you have set this advanced option to TRUE and select a view, the neighbor part 
extension is shown in all drawing views where the view boundary of the selected view is 
displayed.
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Enter a value by which to extend the view in the View extension for neighbor parts in the 
View Properties dialog box. 

If neighbor parts are set to be hidden in the Neighbor Part Properties dialog box by setting 
Neighbor parts to None, the extensions are not displayed even if you set this advanced 
option to TRUE.

TT71411

View frames and
labels

• The size of the drawing frame follows the view content, and updates automatically when there 
are changes in the content. You no longer need to adjust the frame size by dragging view frame 
handles, and this is why the handles have been removed.

• You can still drag a view to a new position by the view frame: click the frame, press and hold 
the left mouse button, and drag the view.

• Now you can pick outside the view frame, for example, to position dimensions. The view frame 
is resized automatically.
The image below shows the three points picked for placing the dimension outside the view 
frame, the resulting dimension, and the moved frame.
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• You can drag view labels and view direction marks: click the view frame to activate the label 
and direction mark handles, press and hold down left mouse button and drag. The view frame is 
resized automatically, if necessary.

View placing • If the view boundary of a view changes in both directions, the center point of the view 
boundary box remains the same.

• If the view boundary is dragged by one corner handle to one direction only, the other corners do 
not move.

• Both of the above apply to view behavior in cloning, updating and manual changes.

• The functionality of the advanced option XS_DRAWING_UPDATE_VIEW_PLACING has also been 
improved

Associativity,
updates and

cloning

• All views are now updated more accurately. 

• All views are now oriented correctly according to the Coordinate system selected in the view 
properties dialog box.

• Dimensions and marks are associated in the rotated coordinate system.

• When a drawing is created, Tekla Structures adjusts the Minimum cut part length in View 
Properties so that the view fills the drawing nicely if you have set Expand shortened parts to 
fit to Yes in the Layout Properties of the drawing. Now Tekla Structures can adjust the 
Minimum cut part length also during cloning and updates, and is able to keep the view length 
as close to the original as possible, and the views no longer become unnecessarily short or long.
TT60539
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• If you are using old models, you need to refresh the associativity of all your drawings in those 
models to utilize the better associativity of the newer Tekla Structures version. This is especially 
important for cloning templates. Do the following:

a Add the command Refresh Associativity to the User menu from the Customize dialog box 
(select Tools > Customize...)

b If you did not have the User menu before, restart Tekla Structures to activate it.
c Open the drawing.
d Click User > Refresh Associativity.
e Save the drawing.

Section view
height and depth

• When you create section views, the section views height and width are defined by the depth of 
the original view.

TT38850

Removed
advanced options

• Because of the improvements in views, the following advanced options are not needed 
anymore:

• XS_DETAIL_VIEW_MAX_GROWTH

• XS_INTELLIGENCE_DO_NOT_ASSOCIATE_VIEWS_TO_GRIDS

• XS_INTELLIGENCE_DISABLE_DETAIL_VIEW_COORDSYS_UPDATE

• XS_DRAWING_CHECK_VIEW_FRAME_AFTER_EDIT

For more
information

Modifying drawing views

XS_DRAWING_UPDATE_VIEW_PLACING

Improvements in drawing colors 
• You now have one more color option, Gray Scale, in the Printer Catalog dialog box. 
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TT53848

• The advanced option XS_USE_COLOR_DRAWINGS that changes the default color mode in 
drawings when the Tekla Structures is started also has one more option GRAY.  

• If you set this advanced option to FALSE or leave the value out, drawings are black and 
white. 

• Set it to GRAY to have gray scale drawings.

• Set it to any other value, for example, COLOR, TRUE or 1, to use colors in drawings.

TT53848

More flexible dimensions and dimension marking 

Creating
dimension line

extensions

• You can now create line extensions for dimensions that have line arrows. To create line 
extensions, enter a value in the Dimension line extension length for line arrow box under 
Drawing dimensions in the Options dialog box (Tools > Options > Options...). 

• The change does not affect existing dimensions.

• Line extensions are not applied to dimensions that have different arrows from line arrows, and 
knock-off dimensions of the following type:

 

TT63984

Selecting
dimension mark

property file

• You can now select the desired reinforcement dimension mark property file through Tools > 
Options > Options... > Drawing dimensions instead of loading the dimension property files 
dimension_mark.dim or tagged_dimension_mark.dim. In some cases the 
reinforcement dimension marks were not created, this has now been fixed.

TT60512

Line extension defined No line extension
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Dimension line
spacing

• Dimension lines spacing is now available in the Dimension Properties dialog box also for 
manually created dimensions. It allows you to place dimensions at given distances, and works 
only if dimension placing is set to free.

 

TT58411

Dragging
dimension marks

• Dimension marks can now be freely dragged to avoid overlapping dimensions and marks.

TT63981

Changing unit
and format for

length in
dimension marks

and tags

• You can now change the unit and format of length in dimension marks and tags. The unit and 
format settings become available when you select a length element in the Elements in mark 
list in the dimension prefix, postfix or tag mark properties dialog box.

TT65791

For more
information

Creating dimension line extensions

Adding predefined reinforcement dimensions

Dragging dimension marks

Setting the appearance of mark text, frames and leader line 
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New tool for dimensioning reinforcing bar groups
The new RebarGroupDimensionPlugin application replaces the earlier StirrupDimPlugin 
application. This new application offers you altogether three dimensioning representations instead 
of one. It also allows you to adjust the placing of the various elements in the dimension annotation 
more flexibly.

• Before you can use this feature in a drawing, add the Create RebarGroupDimensionPlugin 
command to a toolbar in the modeling mode.

• To add the dimension in an open drawing, select the reinforcing bar group and click the 
command Create RebarGroupDimensionPlugin that you added on the toolbar, and then pick a 
location where you want to place the dimension. 

• If you want to modify the dimension properties, for example, how the dimensions and the 
dimension annotations look like, or the spacing between dimension lines and dimension text 
lines, double-click the created dimension.

The new dialog box:

Two new dimensioning representations:
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Example of a representation type:

For more
information

Dimensioning reinforcing bar groups

Improvements in texts, marks and associative notes 

Leader lines • Associative notes and texts added with Add Text tools now have a handle in the leader line 
base point, which enables dragging:
• Text leader line base point can be dragged freely.
• Associative note leader line base point can be dragged in the same way as the leader line 

base point for marks: The leader line base point can be dragged along a line if the base 
point is originally on a line, or inside a part, if the base point is originally inside a part.
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• Previously, the mark or associative note leader line was always pointing to the outer frame of 
the whole mark or note. Now it is possible to set the advanced option 
XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME to the new value 4 to connect the 
leader line to the mark element frame defined in the mark content. This same functionality is 
available for all frame shapes.

TT66099

Number of
reinforcing bars

• You can now show in the reinforcement marks the number of all reinforcing bars that have the 
same position number by adding a User-defined attribute element and entering 
NUMBER_IN_DRAWING as the attribute name. Also the associative notes have the same 
functionality.

TT63994

For more
information

Dragging the mark and associative note leader line base point

XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME

Adding user-defined attributes and template attributes in marks

Improvements in pullout pictures
• The Pullout picture dialog box contains new options for showing the pullout picture in 3D and 

showing the bending radius. If a single reinforcing bar is a 3D reinforcing bar (meaning that the 
points do not lie on the same plane), it is represented with global orientation. 3D pullout picture 
uses global coordinate system. If there are two cast units with different direction in the same 
drawing with similar 3D reinforcement, the pullouts may appear to be different.
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TTT63990, TT63995

• Now there is one more way to show bending radius information in pullout pictures: You can 
make pullout bending radii to use multiplier instead of mm by including  
PullOutBendingRadiusAsMultiplier=1 in the  rebar_config.inp file from the needed 
environment.
In the example below, millimeters are shown:

In the following example, multiplier is used:
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TT66106

• Pullout orientation is now correct. The mark angle does not affect pullout orientation.
TT63992

• Pullout pictures have small leaderlines that point to the dimension text. You can now set a 
minimum length for the leader line to appear in rebar_config.inp with the option 
PullOutLeaderLineMinLength. The default value is 10 mm. To switch the leader lines off 
completely, use a large value.

TT64307

For more
information

Adding pullout pictures in reinforcement marks

Improvements in Rebar mesh view creator

More options The Rebar mesh view creator dialog box has been improved. It now contains more options that 
make it easier for you to create the mesh views just the way you want in one single dialog box.
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• A new option Text content type has been added. Use this to select the wire annotation type.
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• You can now select the property files to be used for various parts of the view in this dialog box.
• The dialog box now contains the standard Save, Load and Save as buttons.

TT72390

Unbending bent
meshes

 RebarMeshViewCreator macro is now able to unbend a bent mesh in the view. The macro 
draws a bent mesh using lines showing the actual unbent mesh. The line properties of mesh wires, 
for example, line type and color, can be controlled through the property file that you select from the 
Unbent wire line.

Note that it is not possible to create an annotation for the bent mesh afterwards similar to 
rectangular or polygon meshes because you cannot select the unbent mesh as a mesh object. If you 
need to update the annotations, please recreate the mesh view. 

The drawing below contains a 3D view of a wall with two bent meshes, and a separate unbent mesh 
view of both of the meshes.
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TT72341

For more
information

Creating a view for a reinforcement mesh

Improvements in welds

Dragging model
welds by leader
line base point

You can now drag the model welds by the base point of the weld mark leader line along the weld 
seam. This allows you to position the weld marks more optimally for increased clarity in the 
drawings. 

 Turn on Smart Select (Tools > Options > Smart Select), this 
makes selecting the leader line base point much easier.

You cannot drag the leader base point to the back-side of a double-
sided weld. 
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The first image below shows the welds in the model, and the second image shows the weld marks in 
a drawing created in the same model. In the second image, the area within which the weld mark 
leader line base point can be dragged is indicated with dark green.
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Setting the
visibility of model

welds

Now you can select the content that is displayed in weld marks of model welds in drawings. 
Previously, you could only adjust the text and line settings. The content adjustments can be done in 
the Welding Properties dialog box on drawing, view and object level.

With this improvement, you can present the weld marks of model welds with exactly the content 
required for each drawing. For example, drawings used in quality assurance might need only a 
tracking number or reference text for welds. Similarly, in fabrication drawings, typical welds show 
only the reference text and the weld type. Furthermore, you get the necessary weld information 
directly from the model, which eliminates the need to create manual drawing weld marks.

The first image below shows the original weld mark of a model weld in a drawing. The second image  
shows the weld content that has been set visible, and the resulting weld mark.



DrawingsNew Features and Improvements 51

Weld mark text
size

• The weld mark texts are now all of equal size.
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TT50009

For more
information

Welds in drawings

Modifying model weld visibility and appearance in a drawing

Model weld visibility and appearance properties

3.6 Import and Export

New way of defining property sets in IFC export 
You can now configure property sets for IFC export in XML format in the new Property Set 
Definitions dialog box. To open the dialog box, go to File > Export > IFC... and click the 
Definitions button. 

First select the XML configuration file from the desired location and the Property set you want to 
work with from the list of property sets included in the configuration file, or create a new one. Then 
you can, separately for each property set, add template attributes and user-defined attributes to the 
property set, and bind the property sets to IFC entities.

Below is an example view of the Property Set Definitions dialog box.
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To configure property sets for IFC export in XML format, you need two files: the schema file 
IfcPropertySetConfigurations.xsd and the actual property set configuration file 
IfcPropertySetConfigurations.xml. The property sets are defined in the Property Set 
Definitions configuration tool. 

You can still use the IFC_properties_sets.inp in addition to the XML file, but the .inp 
based way of configuring property sets is going to be removed at some point.

Each environment comes with an XML configuration file that configures the default property sets. 
You can also define additional property sets of your own. If the model folder contains an XML 
configuration file, XML-based configuration is always used instead of .inp configuration.

IfcPropertySetConfigurations.xsd:

IfcPropertySetConfigurations.xsd is a schema file that describes the structure of the 
XML file and is used for validation of the XML file. You do not need to touch this file, the system 
reads it at startup.

 IfcPropertySetConfigurations.xml:
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• Contains data definitions for properties in the property set:

• Template attribute or UDA name. Template attributes are read from 
content_attributes_global.lst and the user-defined attributes from the 
environment database.

• Data type, such as String, Integer, Float, Timestamp, Boolean, or Logical

• Unit type, such as length, area, volume, or mass

• Unit value scaling of unitless UDA values
• Possibility to use default values

• Possibility to ignore the set to export if template attribute or UDA does not have a value

• Includes property set binding rules to IFC entities:
• Binding to IFC entity type hierarchy including support for not only building elements but 

also for bolts, reinforcing bars, and assemblies 
• Possibility to use limiting rules, such as Equal, NotEqual, LessThan, MoreThan, LessOrEqual, 

and MoreOrEqual
• There can be any number of binding rules for any property set, but only one property set 

definition for each ReferenceId.
• You can bind different property sets to different IFC entity types. For example, a plate may 

have a different property set than a beam.

• The system reads the IfcPropertySetConfigurations.xml file from several directories 
in the below order. If duplicate definitions (same property set ReferenceId) exist, the one read 
first will apply.

• XS_INP

• XS_SYSTEM

• XS_FIRM

• XS_PROJECT

• Model folder

Below is an example of the contents of the IfcPropertySetConfigurations.xml file.

In Property Set Definitions dialog box, you can create the actual 
bindings in the IfcPropertySetConfigurations.xml file on 
the model folder level, even though the data definitions are made in 
another IfcPropertySetConfigurations.xml file in the 
system folder in your environment, for example. When the 
configuration files are read, the XML file containing the data 
definitions is read first and the XML file containing the bindings is 
read the last. This gives you full control over the result from the 
model folder.
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For more
information

Defining property sets using the Property Set Definitions tool

Improvements in IFC export
• The new version of IFC export has been published. Fixes have been made in 

IfcMechanicalFastener (bolts), IfcReinforcement (reinforcing bars), and wallStandardCase 
(panels). Curved beams now have a restricted support for IfcRevolvedAreaSolid. The IFC export 
no longer supports the IFC2x2 schema, only IFC2x3 is supported.

TT65554, TT67452

• The IFC Export dialog box has been improved.
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 The following changes have been made:

• The schema file selection has been removed, because IFC2x3 is used by default.
• The file format is selected in the File format list. The formats are IFC, IFC XML, zipped IFC, 

and zipped IFC XML.
• You can now select many of the options by selecting check boxes instead of Yes or No.
• The dialog box contains a new option Base quantities. If you select this option, additional 

Quantity takeoff add-on view is included to the exported IFC model. 
• The dialog box contains a new button Definitions, which takes you to the Property Set 

Definitions dialog box.
• The data format (as extrusion elements or as boundary representation (BREP)) for 

reinforcing bars can now be selected on the Advanced tab.
• If you want to export grids, select the new Grid check box on the Advanced tab. Grids are 

exported in a separate file called grid.ifc. The IFC grid export is run after the IFC export.
• You can now select whether to export the selected objects (Create selected) or all objects 

(Create all). 

TT71711, TT71762, TT71712, TT69800

For more
information

Exporting IFC

Improved reinforcement export in Publish to Tekla BIMsight
• Reinforcement data requires less space in the IFC files than previously.
• Reinforcement data is now in parametric format which results in smoother navigation in Tekla 

BIMsight.
• In order to export reinforcement data to Tekla BIMsight in an optimized way, select the option 

Include Reinforcements. This option exports the reinforcement as extrusion elements.
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• You can now define properties for exported reinforcements by using the options in the Property 
Set Definitions dialog box. To open the dialog box, click File > Export > IFC... and then 
Definitions in the Tekla Structures IFC export dialog box.

• The improvements made in IFC export offer a more accurate export result. As an example, you 
can now export more detailed reinforcement properties to Tekla BIMsight.

Before improvements:

After improvements:

TT69931, TT69800

For more
information

Defining property sets using the Property Set Definitions tool

Publishing to Tekla BIMsight

Improvements in IFC object conversion
• When custom-shaped profiles are converted, horizontally oriented profiles are rotated 90 

degrees to vertical position before profile is created. This only applies to the profile shapes that 
are recognized. Handles are set to top flange if the vertical slope of the object is below 37 
degrees. 
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• You can now search profiles by name or dimensions. 
If you select the Profile name option, IFC object converter searches profiles by name. If a profile 
is not found, IFC object converter searches profiles by dimensions.

• You can now set tolerance values. The r value affects only rectangular hollow profiles and it is 
used to distinguish hot rolled profiles from cold rolled profiles.

• IFC object converter now recognizes circular and rectangular hollow core profiles.
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TT68260

For more
information

Converting IFC objects into native Tekla Structures objects

IFC Certification 2.0

Description Tekla Structures is taking part in IFC Certification 2.0, which is an improved implementation of the 
former IFC2x, aiming at improving the quality and robustness of IFC implementations. The most 
important achievement of the IFC Certification 2.0 process is a detailed quality control approach for 
the IFC interfaces on top of the self check performed by the software developer. The following 
improvements have been made:

• Coordination view 2.0 (import/ export) is supported
• Constructive Solid Geometry (CSG) import/ export is supported

• Entity count of selected IFC reference model is viewable by inquire command

• Improved visualization of graphical entities that have accuracy problems

For more
information

IFC import

Exporting IFC

Improvements in BVBS export 

Reinforcing bar
length and weight

values

• BVBS export has been changed so that when you set the 
XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT advanced option to TRUE, this user-
defined length value is exported as the overall length for the reinforcement bar in the BVBS file.

Note that the BVBS format specifications define that the overall length of the bar is ignored if 
the data contains actual geometry data. Some other software applications may still use the 
overall length values in the BVBS file for calculating quantities. The exported overall length in 
Tekla Structures is now the same length as that shown in reports.

In addition, the weight for individual tapered reinforcing bars is now correctly written. Earlier, 
the same weight was written for each bar in the group.

TT72775

New  dialog box
options

• The options on the Advanced tab are now reorganized into three groups. The options in group 
Private data are new, and you can use these options to define an additional set of extra 
information allowing the transfer of any project or company-specific data related to each data 
row in the BVBS file.

With Private data block you can control whether the private data block is exported and select 
the data items for this additional block. Data fields can be any report properties, user-defined 
attributes, or object properties. Click the New button to add new predefined items into the list 
by giving following necessary information about the data item.

• Name in list - This is the text shown in the BVBS export dialog box selection list.
• Field identifier - This is the field code which separates the individual data fields in 

the private data block. It can be any lower case letter. Normally, it is good practice to use a 
different value for each data item but this is not required. The receiving system may also be 
able to read only certain data fields.

• Property or UDA name - This value defines which data will be inquired from the 
reinforcement object. Note that a non-existing property will be not exported.

• Property data type - This value has to match the actual selected property.

The added private data field items are automatically saved under the attributes folder in the model.
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TT72465

For more
information

Exporting BVBS

Importing from Tekla BIMsight
You can import reference models from Tekla BIMsight projects.

This supports the workflow where project participants will be combining, clash checking, and 
communicating with models from many disciplines and BIM applications in Tekla BIMsight but want 
to take advantage of the benefits of doing project estimation, scheduling, field layout management, 
facilities management and deployment, among many other benefits, with Construction 
Management module in Tekla Structures.

For more
information

Importing reference models from Tekla BIMsight

3.7 Analysis and Design

Improvements in setting analysis properties for parts
• You can now set analysis properties for parts before creating an analysis model. The analysis 

properties are applied when the parts are added in an analysis model.
• It is now easier to define analysis properties for parts. When you select a class, only the 

available analysis properties based on the selection are available. For example, plates have 
different properties from columns.
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For more
information

Analysis part properties

Improvements in changing model creation method
Now you can change the model creation method of existing analysis models.

For example, you can copy an analysis model that has been created using the Full model creation 
method . Change the creation method for the copied analysis model to By selected parts and then 
remove unwanted objects from the analysis model.

For more
information

Changing model creation method

3.8 Task Manager

Improvements in Task Manager
The following fixes and improvements are now available in Task Manager:
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• Updating and refreshing information in the task list has been improved to be faster than before.
TT61965 

• You can now zoom in and out, lock and unlock all or selected tasks, and copy tasks in the task 
list by right-clicking and selecting the appropriate command on the menu. 

TT55798, TT45990, TT45989

• You can now move and indent more than one task at a time using the Move task up and Move 
task down, and Decrease indent and Increase indent buttons.

TT46782

• Section and floor columns are now available on the Objects tab in the Task Information dialog 
box.
TT67702

• Importing and exporting tasks between Task Manager and MS Project 2010 now works correctly.

TT66798

For more
information

Introduction to Task Manager

Viewing tasks
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3.9 Steel Components

Tensioner (7)
Tensioner (7) connects a column or a beam to a brace with a forked plate or a flat plate. Optionally, 
a gusset plate can be created.

Objects created • Gusset plate (optional)

• Forked or flat plate
• Tensioner (optional)

• End plate (optional)

• Bolts
• Welds

Use for

Selection order 1. Select the main part (column or beam). 
2. Select the secondary part(s) (brace).

Click the middle mouse button to create the component.

Situation Description

Forked plate is welded to a bracing 
rod and bolted to a gusset plate. 

The gusset plate is welded to the 
main part.

Simplified tensioner in the bracing 
rod. 
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Part
identification key

See also Picture

Fork

Parameters

General tab

Bolts

Tensioner (7) (57)

Extra tensioners

Design and Design type tabs

Offshore (9)
Offshore (9) connects a beam to another beam with welds. The component is designed to be used 
in offshore industry for creating notches and complex weld access holes, and to control the notch 
properties. 

Objects created • Notches

• Welds

Part

Connection plate 
(forked plate)

Bracing rod

Gusset plate
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Use for

Selection order 1. Select the main part (beam). 
2. Select the secondary part (beam).

The connection is created automatically when the secondary part is selected. 

Part
identification key

See also Picture 1

Picture 2

General tab

Weld description

Tensioner brace (13)
Tensioner brace (13) creates one or two bracing crosses between two columns or beams. It is also 
possible to add connections between columns or beams and the bracings. You can define which 
connections are used.

Objects created • Bracing cross (1 or 2)

• Connections between columns or beams and bracings

• Connections in bracing cross

Situation Description

Connection between two beams.

Part

Beam

Beam



Steel ComponentsNew Features and Improvements 66

Use for

Selection order 1. Select the first main part (column or beam). 
2. Select the second main part (column or beam).

The connection is created automatically when the secondary part is selected.

Part
identification key

Situation Description

One or two bracing crosses 
between two columns.

To use Tensioner brace (13) you need to set the Up direction on 
the General tab to a fixed direction: -x,+x,-y,+y,-z, or +z.

The Auto option does not work.

Part

Diagonal bracing

Connection between the main part 
and the bracing

Connection in the bracing cross
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See also Picture

Parts

Joints

General tab

Joints direction

Design and Design type tabs

Column - 2 beams (14)
Column - 2 beams (14) connects two beams to a column. The beam ends rest on the column. The 
secondary beams can be horizontal or sloped. The component can also be used with only one 
secondary beam but then the settings are more difficult to define, and there are fewer situations 
where the component can be used.

Objects created • End plates
• Cap plates

• Bolts

• Welds

Use for

Selection order 1. Select the main part (column).
2. Select the first secondary part (beam).
3. Select the second secondary part (beam).
4. Click the middle mouse button to create the connection.

Situation Description

Connection between a column and 
two beams.

Connection between a column and 
a beam.
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Part
identification key

See also Picture

General tab

Bolts 1 - 2

Bolts 3/Bolts 4

Generation of purlins (50)
Generation of purlins (50) creates multiple profiles that can be used as wall or roof purlins, panels, 
or timber or concrete parts. 

Objects created • Purlins

Part

Column

Beam

Beam
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Use for

Selection order 1. Pick the start point of the purlins.
2. Select the parts that divide up the purlins.
3. Click the middle mouse button to create the purlins.

Situation Description

Purlins

Wall panel

The placement of the purlins is defined by the work plane. 
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Part
identification key

See also Picture

Parts

UDA

Squeezed tube bolted (102)
Squeezed tube bolted (102) creates a squeezed part between the main part and a tubular profile. 
The main part must be an I or H profile. The squeezed part can either be a tube that is squeezed at 
one end and then welded to a plate, or a contour plate.

Objects created • Squeezed  tube, or reducing contour plate

• Stiffeners

• Bolts
• Welds

Part

Purlin
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Use for

Selection order 1. Select the main part (I or H profile). 
2. Select the secondary part (tubular profile).

The squeezed part is created automatically.

Part
identification key

Situation Description

A tubular profile is welded to a 
bracing which is bolted to a gusset 
plate. The gusset plate is welded to 
the main part.

A simplified tensioner profile.

Part

Main part (I profile)

Tubular profile
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See also Picture

Parts

Stiffeners

General tab

Bolts

3.10 Concrete Components

Sandwich And Double Wall (1)
Sandwich And Double Wall (1) creates a precast concrete wall. The wall consists of an inner shell, 
foil, insulation, and outer shell.

Objects created • Inner shell
• Foil (optional)

• Insulation (optional)

• Outer shell (optional)

Use for

Situation Description

Sandwich wall, split shells.
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Selection order 1. Pick the first point. 
2. Pick the second point.

The wall is created automatically when the second point is picked.

Part
identification key

See also Parts

Vertical section

Sandwich wall, brick wall on 
outer shell as surface 
treatment.

Situation Description

Part

Inner shell

Foil

Insulation

Outer shell
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Horizontal section

Insulation

Outside Shell

UDA

Sandwich Wall Horizontal Seam (1)
Sandwich Wall Horizontal Seam (1) creates a horizontal seam between two sandwich walls. Seam 
dimensions and rabbets can be defined for all layers: inner shell, foil, insulation, and outer shell. In 
addition, you can define an extra foil layer.

Objects created • Seams 
• Rabbets

• Foil

• Insulation
• Extra foil layer

Use for

Before you start
To be able to select the needed parts, activate the Select objects in components  switch. 

Selection order 1. Select the inner shell of the first sandwich wall. 
2. Select the inner shell of the second sandwich wall.

The seam is created automatically when the secondary part is selected.

Situation Description

Seams between sandwich wall 
shells.

Seams with additional rabbets.
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Part
identification key

See also Picture

Rabbets

Extra foils

General tab

Sandwich Wall Vertical Seam (1)
Sandwich Wall Vertical Seam (1) creates a vertical seam between two sandwich walls. Seam 
dimensions and rabbets can be defined for all layers: inner shell, foil, insulation, and outer shell. 

Objects created • Seam 

• Rabbets
• Foil

• Insulation

Use for

Part

Concrete part (wall, column, 
beam, slab)

Point

Multiple points can be picked.

Situation Description

Seams between sandwich wall 
shells.
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Limitations The component works only if the sandwich walls are parallel.

Before you start
To be able to select the needed parts, activate the Select objects in components  switch. 

Selection order 1. Select the inner shell of the first sandwich wall. 
2. Select the inner shell of the second sandwich wall.

The seam is created automatically when the secondary part is selected.

Part
identification key

See also Picture

Rabbets

General tab

Sandwich Wall Window (1)
Sandwich Wall Window (1) creates a rectangular opening in a sandwich wall. The opening is 
created through up to four parts (inner shell, foil, insulation, and outer shell). A wooden frame can 
be created, as well as extra foils and connection screws. Instead of a wooden frame, a concrete 
border can be added to the inner shell. 

Objects created • Rectangular opening

• Wooden frame or concrete border

Seams with additional rabbets.

Situation Description

Part

Inner shell of the first sandwich 
wall

Inner shell of the second 
sandwich wall
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• Extra foils

• Connection screws

Use for

Selection order 1. Pick the first position. 
2. Pick the second position.

The opening is created automatically when the second position is picked.

Situation Description

Opening in a sandwich wall, with a 
wooden frame and foil layers.

Opening in a sandwich wall, with a 
concrete border in the inner shell.
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Part
identification key

See also Picture

Bottom detail

Top detail

Side detail

Extra Foils

Screws

Connections

Electric box in wall (84)
Electric box in wall (84) creates electric boxes in walls.

Objects created • Electric boxes

• Tubes

Use for

Part

Sandwich wall element

First picked position

Optional: second picked position  

Situation Description

Electric box in a wall with top 
connection.
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Selection order 1. Select a concrete panel. 
2. Pick a position for the electric box.
3. Pick a position for the top connection.
4. Pick a position for the bottom connection.

The electric box and connections are created automatically.

Electric box in a wall with 
bottom connection.

Electric box in a wall with top 
and bottom connections.

Situation Description
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Part
identification key

See also Picture

Parts

Electric box

Top conn / Bottom conn

UDA

Concrete beam-beam (112)
Concrete beam - beam (112) creates a connection between a concrete beam and one or two 
secondary concrete beams. 

Objects created • Neoprene

• Steel plates
• Anchor rods

• Tubes

• Sockets

Part

Electric box

Panel
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Use for

Selection order 1. Select the main part (beam). 
2. Select one or two secondary parts (beam).
3. Click the middle mouse button to create the connection.

Situation Description

Connection 
between two 
concrete beams.

Connection 
between three 
concrete beams.
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Part
identification key

See also Picture

Parts

Anchors

Parameters

Anchor rods

Socket

Concrete foundation (1030)
Concrete foundation (1030) creates a concrete foundation plate at the bottom of a selected 
concrete column. 

Objects created • Concrete foundation plate
• Injection tubes and injection hoses in concrete column

• Up to 4 concrete piles under the foundation plate (optional)

• Stirrups for the reinforcing bars

Part

Beam

Beam
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Use for

Selection order 1. Select a concrete column.
2. Pick a point.

The concrete foundation plate is created automatically when the point is picked.

Situation Description

Concrete foundation plate with 
chamfers, piles, injection tubes 
with curved injection hoses, 
reinforcing bars and stirrups.

Concrete foundation plate with 
more than 4 edges, recesses in the 
foundation plate, and multiple 
reinforcing bars.
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Part
identification key

See also Picture

Parts

Massive

Piles

Inj. tube and rebar

Column

Stirrups

Part

Concrete column

Point

The point defines the new 
bottom level of the column.
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4 Fixes

4.1 Introduction
This section contains descriptions on the numerous fixes and  improvements that have been 
included in Tekla Structures 18.0. Also fixes made for upgrade packages since Tekla Structures 17.0 
are included.

The number after the description of the fix (for example TT12345) is the development item number 
of that particular fix. Your local Tekla office may have referred to this number when you have for 
example submitted a maintenance request. 

4.2 General

Fix list

Mini Toolbar • Mini Toolbar now suggests correct profiles for specific types of model objects, for example, for 
plates. 
TT62537

• Mini Toolbar now works with curved beams.
TT59202

• If the numbering settings are changed in the assembly dialog box, the assembly numbering 
boxes are now dimmed in the numbering series dialog box in Mini Toolbar. 
TT56031

• The green rotation angle knob is highlighted when you move a cursor over it.
Beams are rotated in the same direction as the green rotation angle knob is turned to.

TT50144

• Material name now works correctly.

If you change the material in Mini Toolbar and inquire the part, the correct material is shown in 
the inquiry.

TT47630

Removing
drawing files in

single-user mode

• The single-user mode now has a 7-day safety period for drawing files, after which all 
unnecessary drawing files are removed from the model. Previously, unnecessary drawing files 
were immediately removed in the single-user mode.

TT72169
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Model paths in
multi-byte
languages

•  Using multi-byte characters in model paths caused problems in opening drawings if you had 
English Tekla Structures and multi-byte locale Windows operating system. To fix this, you can 
now use the advanced option XS_STD_LOCALE, and set it to one of the following values in the 
teklastructures.ini file, depending on the locale of your operating system: 

• set XS_STD_LOCALE=japanese

• set XS_STD_LOCALE=chinese-traditional

• set XS_STD_LOCALE=chinese-simplified

• set XS_STD_LOCALE=russian_us.1251

If  you set XS_STD_LOCALE to any other value, or leave the value out, English locale is used 
by default.

Restart Tekla Structures after changing the value to activate the new setting.

TT72317

4.3 Modeling

Fix list

Expanding work
area

• The work area is now expanded correctly for rotated views.

TT71648

Part profiles • The web thickness of the HD360x196 profile is now correct, 16.4 mm, in the default 
environment.

TT70870

Copying and
moving objects

• You can now copy cuts and fittings even if the source and target object are not similar. For 
example, it is possible to copy a cut from a beam to a column as it is.
TT51544

• Previously, if you tried to move part edge chamfers for parts at a location with either the x or y 
coordinate as 0, the chamfers still belonged to the original part. This has now been fixed.

TT66756

Snapping • Snapping to exact geometry now works for bolts and bolt holes.

TT72914

Area calculations • Area calculations are now more precise for hollow core slabs having cuts and cast units 
containing sandwich elements.

TT59433

This advanced option is system-specific. Generally, there is no need 
to modify system-specific settings. Do not modify them if you are 
not an administrator.
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4.4 Reinforcement

Fix list

Polygonal mesh • Polygonal meshes with Multiple varying distances spacing method now display the correct 
mesh size when the display representation is set to Fast.

Also the outline representation in drawings now displays the correct mesh size.

TT66707

Cover thickness • You can now enter two values for From plane cover thickness in reinforcing bar groups and 
bent meshes. If you enter only one value, the value is applied to two sides in the same way as 
before.

TT50510

4.5 Drawings

Fix list

Grids in drawings • Grids now work more consistently than before. For example, grid labels are always at the 
wanted end, and label offsets are always at same ends. Improvements were also made in grid 
cloning. 

Views •  View scale could not be modified from drawing level. This has now been fixed.
TT70332

• When you created a drawing view from the model using the command View > Create Drawing 
View > Of Entire Model View, the new view was sometimes placed far away outside the sheet 
and was not visible. This has now been fixed.
TT74041

•  View depth of a main view (front, top, back, bottom) of an assembly drawing was extremely 
large: it contained the whole neighboring part if bolts were dimensioned to working points. This 
has now been fixed.
TT74177

• The setting Center by view restriction box in cast unit drawing section view properties did not 
stay on when you adjusted it on drawing level. This has now been fixed.
TT70833

•  Now the Fit by parts option includes visible reinforcing bars inside the view boundary. This 
happens also in intelligent update.
TT71300

• Setting Align section views with main view to Yes to place the section views next to the main 
view was not working if the main view was vertical. This has now been fixed.
TT73355

• Key plan views occasionally caused application errors. This has now been fixed.

TT69835
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Drawing size • If you had set Include single parts to Yes but you did not have any single-part views in the 
assembly drawing, then the drawing size in the Drawing List was the preferred size, not the 
actual size of the drawing.

TT73291

Dimensions • Reinforcement dimensions did not always show the selected contents. This has now been fixed.
TT70882

• Tekla Structures sometimes tried to update a grouping of manually created dimensions. This is 
not done anymore, because it would break the dimensions.

TT71755 

Snapping • Snapping in drawings did not work for perpendicular lines, for example straight reinforcing bars 
or reference lines. This has now been fixed.
TT70534, TT71301

• Orthogonal snapping was not working in drawings. This has now been fixed.
TT68648

• Now it is possible to snap to reference object geometry in drawings.
TT66136

• Snapping now shows better which lines you are snapping in drawings. 

TT71131

Dragging • Dragging by handles is now more accurate. Before, when you dragged by handles, Tekla 
Structures snapped to the point in the handle that was grabbed. Now Tekla Structures snaps to 
the middle point of the handle.

TT67906

Undo • Selecting Undo after layout modification did not update the view properly Now Undo works 
correctly.

TT70965

Selecting and
highlighting

• Drawing objects with text fields are now highlighted correctly when selected. Also objects with 
solid fill are more clearly highlighted when selected.

TT64844

Updates and
cloning

• General arrangement drawing views were sometimes moving during drawing update. This has 
now been fixed.
TT70449 

• The cloned drawing did not contain all parts in some rare cases where the source drawing 
contained some detail or section views in addition to the main view. 

TT71999

Reinforcing bars • The reinforcing bar line width was sometimes incorrect. This has now been fixed.
TT71959

• Bending symbols (O, X) are no longer drawn in section views for reinforcing bars that are only 
slightly bent (the bending angle is less than 5 degrees). These kind of reinforcing bars are 
typical, for example, in bridge constructions.
TT69729
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• When reinforcing bars were hidden in a drawing, selecting Tools > Options > Deactivate 
Ghost Outline caused an application error.
TT72035

• Representation of reinforcing bars that point away from the drawing is now changeable. You 
can customize reinforcing bar end symbols (cross, circle, filled circle) in a symbol file by editing 
the symbol file rebar_end.sym, which in the default environment is located in  
..\ProgramData\Tekla 
Structures\<version>\environments\common\symbols. Or, you can create a new 
symbol file in the same folder, for example, my_new_symbols.sym, and take it into use in the 
rebar_config.inp by entering the following string: EndSymbolFile=my_new_symbols.sym
TT67680

• Circular reinforcing bar group hooks were not created correctly in drawings. This has now been 
fixed.

TT73244

Reinforcement
meshes

• You can now select the line type for the crossing line of the reinforcement mesh outline on the 
Appearance tab of the reinforcement mesh properties dialog box. Before, a solid line was 
always used.

TT70346

Marks and
associative notes

• In general arrangement drawings, part marks of cast units now correctly indicate the 
orientation of part. They now behave in the same way as part marks of steel assemblies. 
TT69939

• In bolt marks and associative notes, using BOLT_FULL_NAME inside the Size element in mark 
resulted in an incorrect name if there were several different lengths of bolts with the same 
standard. This has now been fixed.
TT70598

• When you added a round frame around an element in a mark, the outer frame did not adjust 
accordingly, see example below. With other element frame types the outer frame adjusted. This 
has now been fixed.
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TT70545

• Reinforcing bar mark base point was incorrect if one of the reinforcing bars in a group was 
visible, and the mark was created far away from the view. Now the mark is freeplaced in a 
correct position when it is created even if its placing is set to fixed.
 TT70988 

• When you added elements in connection marks in the Connection Mark Properties dialog box 
and saved the drawing properties, and the loaded the same property file again, the added 
connection mark elements were not kept. This has been fixed, and now the connection mark 
elements and properties are loaded correctly again.
TT58941

• If you use a template as the content of a mark in a drawing, the dimension fields for tapered 
reinforcing bars now show the correct values for different segment lengths. Previously, Rebar 
Shape Manager always showed the same length for the fields.

TT68101

Multidrawings • If an assembly drawing included linked single-part drawings, and the assembly drawing was 
linked in a multidrawing, updating the assembly drawing deleted the link between the assembly 
drawing and the multidrawing. This has now been fixed.

TT70393

Confirming re-
creation of

drawings

• When you were changing the object level settings, you could not confirm or skip the re-creation 
of drawings using Y and N on the keyboard. Now the keyboard commands are working again.

TT59401 

Hatches • Hatches with background color no longer cover the underlying objects.
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TT68973

Toggle button • In the Weld Mark Properties dialog box, the check box next to Stitch weld was not cleared 
when you pressed the toggle button. This has now been fixed.

TT72263, TT71303

Pullout pictures • The protection area of the pullout pictures was not working correctly. This has now been fixed.

TT71936 

XS_ENABLE_PRE
_TS16_CLASSIFIE

RS

• The advanced option XS_ENABLE_PRE_TS16_CLASSIFIERS is no longer supported.

XS_DISPLAY_ZER
O_INCHES

• If you do not give any value to the advanced option XS_DISPLAY_ZERO_INCHES, Tekla 
Structures does not show zero inches even if there are feet and fractions in the dimension 
value. 

TT73164

4.6 Templates and Reports

Fix list

Template rows • Template rows for which some values cannot be resolved are now sorted correctly.

TT70522

Reinforcing bar
bending shapes in

templates

• In some cases using the new reinforcing bar shape recognition from the 
RebarShapeRules.xml file by setting XS_USE_USER_DEFINED_REBARSHAPERULES to TRUE 
made opening drawings very slow as accessing templates was slow. This has now been fixed.

TT65554

Reinforcing bar
bending shapes in

html lists

• The pullout pictures of the bending shapes are now shown correctly. They were broken in 
version 17.0.5.

TT72659

Multi-sketch
profiles in reports

• It is now possible to create a report using properties of multi-sketch profiles. The correct values 
are returned for all cross section numbers. Previously the properties were fetched from the first 
cross section only.

TT70557

XS_USE_NEW_PL
ATE_DESIGNATIO

N

• Now the advanced option XS_USE_NEW_PLATE_DESIGNATION has  three options available:

• Not used at all (values is blank or FALSE).

• Used only for steel parts (value is FOR_STEEL_PARTS_ONLY).

• Used for all parts (any value except FALSE or FOR_STEEL_PARTS_ONLY. TRUE is 
recommended.

Now users using role All with both steel and concrete elements have the possibility to use 
the option only for steel parts.

TT71701
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4.7 Import and Export

Fix list

BVBS export • Previously, the BVBS group identifier was not correct (BF2D) for single reinforcing bars with a 
3D shape. This has now been fixed. The correct 3D group identifier (BF3D) is exported. The error 
only affected single reinforcing bars. Normal and tapered reinforcing bar groups with 3D shapes 
were exported correctly.

TT72459

IFC export • Reinforcements with invalid coordinate systems are now corrected in IFC export. The user is 
notified by an error message in the export application output.

TT68414

Converting IFC
objects

• The maximum number of characters in the profile section name is 19. If the limit is exceeded, 
the section name is cut to the limit and a warning message is displayed on the status bar.

TT65385

NC files • CNC hard stamps (SI block) is now printed in the NC file when using the Project number or Lot 
number elements in NC file settings. The NC definition files already using Project number or 
Lot number elements in hard stamps should be deleted and redefined.
TT70726

• The top diam value is now used for the top diameter of countersunk bolts instead of the span 
size value.
TT70325

• According to the DSTV standards the description of the CSK (countersunk) hole in the BO block 
should be reverse. The description has now been changed to be in the following order 
recommended by the DSTV standards:

TT57750 

• Concrete objects were listed in MIS list and NC files. This has now been fixed, and concrete 
objects are no longer listed in MIS list and NC files.
TT73029

• Tekla Structures kept asking to execute numbering, when you tried to  create NC Files. The 
cause was that you were exporting selected parts whose similar parts belonged to assemblies 
that were not up-to-date. This has now been fixed.

TT70842

HMS export • If the .sot file name is too long, HMS export now requests the user to change the name so 
that is it within the limitation of 24 characters.
TT70986

• The correct slab width CO is now exported for panels with complex shapes.
TT71451

• The option to export cores has been renamed to Export inner cores. Previously, the option was 
Export Open Cores VS/VT.
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TT71448

• You can now select whether to save the export file as a .sot file or all files (*.*).

TT71325

Reference models • Now the XS_REFERENCE_CACHE advanced option setting correctly relates relative paths to the 
current model folder.

TT66766

4.8 Analysis and Design

Fix list

Connections
between analysis

members

• In some cases, connections between primary and secondary analysis members were not created 
correctly. Part height was also calculated incorrectly. This has now been fixed.
TT67246

• Sometimes, a secondary member which was connected to a connection node had an 
unnecessary extra rigid link to a primary member. This has now been fixed.

TT71207

Builtup sections
in the analysis

model

• If part is a builtup section in the analysis model, the name of the builtup section can be entered 
as Replacement profile name on the Bar attributes tab of the Analysis Part Properties dialog 
box. Any name can be entered, but if the name matches an existing catalog profile name, the 
physical properties of the section will be the same as the catalog profile properties.

TT66341

New warning
message

• Warning added for the situation where a rigid link cannot be created because the nodes are too 
close to each other. This can happen if beam axis movement (of both connecting beams) has 
been restricted so that it is not possible to create the connection without rigid link. The new 
warning message: "WARNING: The nodes are too close to create a rigid link, please check part 
axis restrictions, part Id: 1, nodes Id: 2 Id: 3."

TT69700

Removal of AISC
connection design

• The AISC connection design has been removed from Tekla Structures. The options related to the 
AISC design have been removed from the Design and Design type tabs of the component dialog 
boxes.

TT71346

4.9 Construction Management

Fix list

Model Organizer • Previously, when you tried to drag and drop objects from one category to another in a logical 
area, the objects disappeared from the categories if you clicked No in the Classify objects 
dialog box. Now the objects do not disappear anymore but remain in their original category.
TT69246
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• Previously, if you selected an object type category and its subcategories and deleted them, the 
subcategory was deleted twice causing an error dialog box to be displayed. This has now been 
fixed.
TT72148

• Dates are now shown correctly in the object pane when their type is date.
TT69401

• The values of calculated properties are now rounded correctly. The rounding precision is defined 
in the Properties dialog box.
TT71887

• When customizing object properties in the Properties dialog box, you can now save the 
customized properties to a file and load new properties from a file.
TT72492

• Model Organizer now automatically resolves conflicting classifications that might occur in the 
Logical Areas in multi-user mode. The conflicts are checked when you open Model Organizer. 
If any object is classified in more than one section or story, or if an assembly containing the 
object is not classified in the same section or story than the object, the object is moved to 
resolve the conflict.
TT60665

• If the Model Organizer dialog box was moved to a secondary screen, Model Organizer could 
not be accessed anymore after the secondary screen was disconnected from the computer. This 
has now been fixed.

TT74439

Task Manager • Sometimes, when you saved and reopened a model, task types had been removed from tasks. 
This has now been fixed.
TT71287

• When you tried to create a selection filter for tasks and used the Select from model option, 
there was an application error. This has now been fixed.
TT65406

• Task Manager now functions faster than before when task dependencies are imported from MS 
Project.
TT68759

• When importing tasks to Task Manager, existing tasks are now overwritten correctly if the 
Override existing tasks option is selected.
TT72506

• Previously, when you tried to print a Task Manager scenario in an adjusted size, there was an 
application error. This has now been fixed. Printing from Task Manager functions correctly.

TT70117

4.10 Custom Components

Fix list

Custom
component editor

• You can now get the actual diameter of reinforcing bars in the custom component editor using 
the formula =fRebarCatalogValue(BarGrade, BarSize, Usage, 1).

TT72743
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Reinforcing bar
group properties

• The Creation method property is now available for reinforcing bar groups in the custom 
component editor.

TT72460

4.11 System Components

Fix list - steel connections

Tensioner (7) • The forked plate is now cut as defined with the Cut part B in fork option on the Tensioner tab 
and Extra tensioners tab.

TT68091

Pipe Column and
Beam Panel Zone

(21)

• In some cases, defining haunches as Specified caused errors in the model. This has now been 
fixed.

TT67692

End plate (29) • The end plate is now positioned correctly.

TT70500

Two sided clip
angle (33), Two
sided end plate

(34)

• The Copes 2 tab now controls the notches in the first secondary part and the Copes 3 tab 
controls the notches in the second secondary part.

TT71637

Bolted moment
connection (134)

• The gap between the column and the stiffener plate is now created correctly. Previously, 
defining the gap on the Stiffeners tab caused the shear plate to clash with the lower flange 
plate by the distance you entered as the gap size.

TT62373

• Stiffeners are now positioned correctly when you define the stiffener offset from the edge of 
the beam.

TT73835

Two sided end
plate (142)

• You can now control how many bolts there are on each side of the safety connection.

TT67732

Two sided clip
angle (143)

• You can now define a finish for the angles on the Parts tab and the Angle box tab.

TT69395
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Fix list - steel details

Handrailing
(1024)

• Previously, handrailings were not aligned correctly with U-profile stairs (Stairs S71)). This has 
now been fixed.

TT71351

U.S. Base plate
(1047)

• Shim plates are now correctly offset with the bolts and the base plate.

TT70376

Fix list - steel modeling tools

Rectangle to
circle (17)

• Corner triangular plates between two parts are now created correctly. Previously, when the 
distance between the parts was long, the plates were sometimes created too short.

TT68610

Trigangles
generation (19)

• When you selected to create triangles using points read from a file and the file did not exist, 
there was an application error requiring  you to restart Tekla Structures. This has now been 
fixed.

TT70432

Generation of
purlins (50)

• Purlin distances are now created correctly for sloped beams with the Exact number of purlins 
and Fill to the end options.
TT68079

• Purlin distances are now created correctly with the Divide equally option.
TT68081

• Purlin overhangs are now created correctly when you have defined on the Parts tab that the 
local direction of the purlin is inverted.
TT68082

• The purlin position in the horizontal plane now works correctly for purlin overhangs when 
defined with the Position in plane option on the Parts tab.

TT68083, TT68085

Kickplate (S75) • The weld between the kickplate and the stanchion was not created without extensions of the 
left or right side. This has now been fixed.
TT71246

• Previously, the material you defined for the kickplate on the Parameters tab was not applied. 
This has now been fixed.

TT71241

Fix list - concrete components

Floor Tool • Slabs are now cut correctly in all directions.

TT68760

Sandwich Wall
Window

• Previously, when you selected not to create a wooden frame, there was an error message. This 
has now been fixed.
TT71489
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• Previously, creating a window in a concrete wall placed some of the window parts outside the 

wall. This happened when the   mirroring option was used in a wall created 
with the Sandwich and Double Wall modeling tool. This has now been fixed.

TT71104

Concrete
foundation

(1030)

• Injection tubes are now cut along the part edge. Previously, when you used the tube option to 
define the slope of the tube, the cut was not made correctly.

TT71819
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